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Chapter 17 Feature Definitions 

Feature Definitions are used in drafting, 3D modeling, and quantity calculations.  This chapter explains the 
various types of Feature Definitions used in the ORD software, as well as editing and creating new Feature 
Definitions. 
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17A – INTRODUCTION TO FEATURE DEFINITIONS 

Feature Definitions are assigned to ORD geometry elements, Terrain Models, Corridors and many other 
element types.  Feature Definitions are used to organize elements based on their material type or function 
in 3D modeling and drafting.  When quantities are calculated, all elements of the same Feature Definition 
are summed together in the quantities report. 

NOTE: MicroStation Elements (i.e., Smart Lines, Line Strings, and Complex Chains) do NOT 
contain a Feature Definition or Feature Name.  However, a MicroStation Element can be manually 
assigned a Feature Definition with the Set Feature Definition tool. 

A Feature Definition is a set of attributes that affect the Level, symbology (Color, Line Style, Weight), 
behavior, and functionality of an element.  For example, changing the Feature Definition for a Terrain 
Model affects which component elements (i.e., contours, boundary, triangles) are shown. 

The behavior and functionality of Feature Definitions depends on the element type.  For example, Linear 
Feature Definitions are relatively simple and primarily affect the Level, Color, and Line Style of an 
element.  In contrast, Corridor Feature Definitions affect modeling and display settings for the Corridor, 
such as the density (Template Drop interval multiplier) of the Corridor model. 

Feature Definitions are shown and switched in the Properties  box. 

 

Feature Name: Every element with a Feature Definition also contains a Feature Name.  The Feature 
Name conforms to the FLH Feature Naming Convention.  The FLH Feature Naming Convention is shown in 
3F – Naming Convention for Proposed ORD Features.  In general, assign significant geometrical elements 
a logical and appropriate Feature Name.  Name all Baselines (Centerline), Profiles, Culverts, Terrain 
Models, Corridors, Linear Templates, and Surface Templates. 

The Feature Name is assigned in creation of the element.  If a Feature Name is NOT manually entered, 
then a default name is automatically assigned based on the name of the Feature Definition. 

Elements should always be assigned a logical Feature Name for the following reasons: 

• When Alignment, Profiles, Corridors, and Terrain Models are exported as Physical Data for 
construction staking, the Feature Name is embedded in the exported file. 

• If Feature Names are NOT assigned, then it is very difficult to distinguish between elements in the 
OpenRoads Modeling drop-down found in the Explorer . 
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17A.1 Feature Definitions and Levels 

The Feature Definition controls the Level, Color, Line Style, Weight and other graphical properties of the 
element.  Changing the Feature Definition will automatically change the Level and other graphical 
properties. 

 

WARNING: If an element is assigned a Feature Definition, do NOT manually change the Level.  When the 
element is edited, the Level will automatically revert to the Feature Definition’s default Level. 

BACKGROUND INFORMATION: Each Feature Definition is assigned an Element Template.  An Element 
Template is a set of properties and attributes, such as Level, Color, Line Style, Weight, and Material.  To 
view the Element Template and other properties assigned to a Feature Definition, see 17C.2 Edit an 
Element Template. 
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17A.2 Featurized Elements in the Explorer (OpenRoads Model) 

Every element that contains a Feature Definition is shown and organized in the Explorer  under the 
OpenRoads Model drop-down.  Also, elements can be directly manipulated from this location. 

The OpenRoads Model drop-down is organized by: 

Feature Definition Type → Feature Definition → Feature Name (element) 

 

NOTE: The OpenRoads Model drop-down (shown above) is for organizing and manipulating elements 
created in the current ORD File.  The OpenRoads Standards drop-down shows all Feature Definitions in 
the FLH Workspace and can be used to edit or create a new Feature Definitions. 

NOTE: Always assign featurized elements an appropriate Feature Name.  If Feature Names are NOT 
assigned, then it is difficult to distinguish between elements in the OpenRoads Standards drop-down. 
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TIP: For Alignments and Linear Geometry, the corresponding Profile element can be seen by expanding 
the horizontal element. 

 

TIP: Expand a Corridor to view all Linear Elements (Features) and Components (Meshes) that are 
generated by the Corridor. 
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17A.3 Feature Definitions in the Explorer (OpenRoads Standards) 

Feature Definition are shown and edited in the OpenRoads Standards drop-down in the Explorer. 

The OpenRoads Standards drop-down is organized into two parts: the Libraries drop-down and Current 
ORD File drop-down. 

 

Libraries: All Feature Definitions in the FLH WorkSpace are shown in the Libraries drop-down.  However, 
Feature Definitions CANNOT be edited from the Libraries location. 

Current ORD File: The second drop-down is named after the current ORD File.  Only Feature Definitions 
that are used in the current ORD File are shown in this location.  Any Feature Definition found in this drop-
down can be edited. 
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Libraries: Under the Libraries drop-down, there are two Feature Definition Libraries. 

Feature Definition Library #1: Features_Settings_Annotations_Levels_Elem Temp.dgnlib – This 
library contains the vast majority of Feature Definitions in the FLH Workspace. 

Feature Definition Library #2: DU_Features_Settings_Annotations_Elem Temp.dgnlib – This 
library ONLY contains Feature Definitions used in Drainage and Utilities (SUDA) modeling. 
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Current ORD File: Only Feature Definitions used in the current ORD File are shown in this location. 

 

TIP: To view and edit properties of a Feature Definition, right-click on it and select Edit Feature Definition. 
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17B – FEATURE DEFINITION TYPES AND LIBRARIES 

Feature Definition libraries are sorted by element type.  The graphic below shows all Feature Definition 
types used in the FLH WorkSpace. 

 

The following Feature Definition Types are commonly used: Alignment, Terrain, Corridor, Linear, and 
Mesh. 

Understanding the functionality of these Feature Definition Types is necessary for modeling and quantities 
calculation operations. 



 

17-10 

17B.1 Alignment and Linear Feature Definitions 

The Alignment and Linear Feature Definitions are used to draw Horizontal and Vertical (profile) ORD 
Elements. 

All Alignment and Linear Feature Definitions in the FLH Library are shown in the Feature Definition Tool 
Bar.  The Feature Definition Toolbar is discussed in 7B.3 Feature Definition Toolbar. 

BEST PRACTICE: Explore and become familiar with the categories and organization of the 
Alignment/Linear Feature Definition library. 

 

Alignment Feature Definitions: These Feature Definitions are specifically used to draw horizontal and 
vertical geometry for the proposed centerline of road.  For example, the mainline centerline of road should 
be drawn with the “Baseline” Feature Definition.  An intersecting approach centerline should be drawn with 
the “Baseline – Approach” Feature Definition. 

The “Baseline – Alt 1,2,3” Feature Definitions are intended for alternate alignments and temporary traffic 
control detour alignments. 
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Linear Feature Definitions: These Feature Definitions are used to draw horizontal and geometry.  For 
example, the centerline and profile of a Culvert should be drawn with the “Pipe culvert” Feature Definition. 

 

After the Profile element is activated, then a 3D Linear Element is created in the 3D Design Model .  The 
3D Linear Element is assigned to the same Feature Definition as the horizontal element (in the 2D Design 
Model ). 
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17B.1.a Linear Feature Definitions in Corridor Modeling 

In Corridor modeling, Template Points are extruded as 2D and 3D Linear Elements.  Feature Definitions 
for the resulting 2D and 3D Linear Elements are assigned in the Template Point Properties menu.  
Template Points utilize the Linear Feature Definition library. 
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17B.1.b Create Template Geometry Setting for Corridor Modeling 

By default, a small selection of Template Points is created directly in the 2D Design Model  as 2D Linear 
Elements.  The Feature Definition determines if a 2D Linear Element is created from a Template Point. 

For example, the “Edge of Pavt” Template Point produces a 2D Linear Element in the 2D Design Model .  
The “Subgrade“ Template Point does NOT. 

The “Create Template Geometry” Feature Definition setting enables the creation of a 2D Linear Element.  
For the “Subgrade” Template Point, “Create Template Geometry” is set to False, which means a 2D Linear 
Element is NOT created. 

 

NOTE: Feature Definition settings are accessed through the OpenRoads Standards drop-down in the 
Explorer .  Accessing and editing Feature Definition settings is discussed in 17C – Feature Definition 
Settings and Editor. 
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17B.2 Mesh Feature Definitions 

Mesh Feature Definitions are assigned to Template Components in Corridor, Linear Template, and 
Surface Template modeling. 
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17B.2.a Mesh Feature Definitions in Quantity Calculations 

When quantities are calculated, Template Components of the same Mesh Feature Definition are summed 
together in the report. 

For example, if two disconnected Template Components are assigned the same Feature Definition, then 
their volumes will be summed together in the quantities report. 

 

Assign the disconnected Template Components different Feature Definitions to separate them in the 
quantities in the report. 
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17B.2.b Volume Option Setting for Earthwork Calculations 

Volume Option is a Feature Definition setting that applies to Mesh and Terrain Feature Definitions ONLY.  
The Volume Option determines how Meshes and Terrains are analyzed in earthwork calculations.  Volume 
Option is discussed in 20G – Advanced Information: Component Feature Definition and Volume Options. 

 

NOTE: In the FLH WorkSpace, the Volume Option for each Mesh and Terrain Feature Definition is pre-
configured.  In most circumstances, it is unnecessary to alter the Volume Option. 

When creating new Mesh Feature Definitions, ensure the Volume Option is set appropriately. 

Proposed materials (i.e., asphalt and aggregate) should be set to the “Design” Volume Option for 
consideration in earthwork calculations.  When an element is set to the “Design” Volume Option, then the 
cut/fill quantities are calculated for placement of the element, with respect to the existing ground 
elevation. 

If a new Mesh Feature Definition should NOT be considered in earthwork calculations, then set the Volume 
Option to “None”. 
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BACKGROUND INFORMATION: The Create Cut Fill Volumes tool creates Cut and Fill Mesh components, 
which are summed and tallied in quantities reports.  To generate Cut and Fill Meshes, the Volume Option 
for all Template Components and Terrain Models are analyzed. 

NOTE: The Create Cut Fill Volumes tool is discussed in 20B – Create Cut Fill Volumes tool and 
Earthwork Calculations. 

In the example shown below, ALL Road Corridor Components are assigned to the “Design” Volume Option.  
The Create Cut Fill Volumes seeks out the bottom of the “Design” Components to create a sub-grade 
datum. 

The Existing Ground Terrain Model is assigned to the “Existing” Volume Option. 

Cut and Fill Components are created between the “Existing” Terrain Model and the sub-grade datum of the 
“Design” Components. 
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17B.3 Corridor Feature Definitions 

The Corridor Feature Definition primarily affects the density of the Corridor. The Corridor Feature 
Definition Library is found and changed in the Properties  box when the Corridor Handle is selected.  
This section provides a high-level overview of the Corridor Feature Definitions.  However, for more 
information, see 9D.2 Corridor Feature Definitions: Design and Final. 

 

Design: When the Corridor Feature Definition is set to Design, the Interval is multiplied by 2.  As shown 
below, the Interval is set to 10 feet in the Template Drop element properties.  However, the actual 
Interval is 20 feet due to the Interval Multiplier imposed by the Design Feature Definition. 

Final: When set to Final, the Template Drop Interval is set to 1.  The actual Interval matches the 
Interval set in the Template Drop element properties. 
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BEST PRACTICE: The Final Feature Definition is easier to work with because there is no multiplier 
applied to the Template Drop Interval.  However, the Final Feature Definition may increase processing 
times because the Corridor is denser.  When set to the Design Feature Definition, the Corridor is less 
dense and will process faster. 

It is acceptable to set and leave the Corridor Feature Definition assigned to Final if processing times are 
acceptable.  For example, relatively simple Corridors will NOT suffer a significant performance decline 
when set to the Final Feature Definition. 

For complex Corridors, it is recommended that the Corridor Feature Definition is set to Design when edits 
are being made to the Corridor, Alignment, Profile, and all elements that interact with the Corridor.  Set 
the Corridor to the Final Feature Definition when performing the following tasks: 

• Calculating Quantities: Quantities will be more accurate if the Corridor is denser. 

• Creating Proposed Terrain Models from the Corridor: The Proposed Terrain Model will be 
smoother, and a more accurate surface is produced. 

• Printing Road Plan and Profile Sheets: When the Corridor is set to Final, the Cut/Fill linework 
will slightly alter because more Template Drop sections are added.  It is advised that the Cut/Fill 
linework aligns with the resulting Proposed Terrain Model and Quantities Calculations. 

After performing the tasks listed above, change the Corridor Feature Definition back to Design. 

Other Final Feature Definitions: There are two other Final Feature Definitions that are used for 
specific tasks. 

Final Breaklines Only: This Feature Definition is ONLY utilized when generating the 3D Breaklines DXF 
File for Physical Data package.  See 23H – Proposed 3D Breaklines in DXF File Format.  When switched to 
this Feature Definition, ONLY 3D breaklines are shown from the Corridor in the 3D Design Model .  All 
other Corridor elements (i.e., Components and Meshes) are hidden, making it easy to select the 3D 
Breaklines. 

Final w/ Contours: When switched to this Feature Definition, elevation contours are shown around the 
Corridor Model.  NOTE: The contours are placed in 3D Design Model .  The contours can only be seen in 
the 2D Design Model  if the display for the 3D Design Model  reference is toggled ON. 
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17B.4 Terrain Feature Definitions 

Terrain Feature Definitions are used with Terrain Model elements.  The Terrain Feature Definition Library is 
shown in the Properties  box when a Terrain Model is selected. 

 

There are 5 categories of Terrain Feature Definitions:  

 Terrain Model Feature Definition Categories  

Category: Description: Volume Option 
Existing Terrain Models that represent the Existing Ground surface. Existing 

Existing 
Features 

Terrain Models that represent Existing Features, such as existing 
buildings, existing topsoil, existing gravel, and existing pavement.  
Existing Feature Terrain Models are primarily used to calculate and 
account for unsuitable materials in earthwork quantities.  

None 

Design 
Terrain Models that represent the Finished Grade surface of a proposed 
feature. 

Design 

Subgrade 
Terrain Models that represent the Subgrade surface of a proposed 
features. 

Subgrade 

Civil Cell For use in Terrain Models within Civil Cells. None 

The category has two primary effects on a Terrain Model: 

• Printed Appearance: When printed on paper or PDF, the category affects the color and line weights 
of the contours and contour labels.  For example, the Existing category produces contours and 
labels that are light in color and line weight.  The Design category produces darker and heavier 
weight contours. 

• Quantity Calculations: The Volume Option is a Feature Definition setting that determines how the 
Terrain Model is treated in earthwork quantities calculations.  The Volume Option setting also 
applies to Mesh Feature Definitions and is explained in 17B.2.b Volume Option Setting for 
Earthwork Calculations. 
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When a category drop-down is expanded, a list of Feature Definitions is shown.  All Terrain Feature 
Definition adhere to the same naming convention.  The Feature Definition name indicates which Terrain 
Model components are displayed. 

For example, “Design_Boundary” only shows the boundary of the Terrain Model.  “Design_Contours_1’-5’” 
shows the minor and major contours (in 1’ and 5’ increments respectively) and the boundary of the 
Terrain Model. 

 

NOTE: Terrain Feature Definitions are graphically demonstrated in 5B.1 Feature Definition Settings for the 
Existing Ground Terrain Model. 
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17C – FEATURE DEFINITION SETTINGS AND EDITOR 

Feature Definition settings are shown and edited in the Feature Definition Editor.  The Feature Definition 
Editor is accessed through the OpenRoads Standards drop-down in the Explorer . 

 
To open the Feature Definition Editor, right-click on a Feature Definition and select the Edit 
Feature Definition tool. 

 

The graphic above shows the general settings for a Linear Feature Definition.  Feature Definition settings 
are slightly different, depending on the selected Feature Definition Type. 

 

Feature Definition Type Settings: These settings are unique to the type of Feature Definition. 

NOTE*: The “Create Template Geometry” setting is shown when a Linear Feature Definition is 
selected.  The “Volume Option” setting is shown when a Mesh or Terrain is selected. 

 

Feature Symbology: The Feature Symbology setting determines the graphical appearance and 
annotation capabilities of the Feature Definition.  On the left-side of the editor, expand the drop-
downs to show Feature Symbology settings. 

NOTE**: Most Feature Definition Types only have a single Symbology setting.  However, the 
Alignment and Linear types have two Symbologies: Linear and Profile.  The Linear Feature 
Symbology controls the Feature Definition appearance in the 2D Design Model  and 3D Design 
Model .  The Profile Feature Symbology controls the appearance in the Profile Model . 
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17C.1 Feature Symbologies and Element Templates 

Feature Symbologies are a collection of settings that determine how the Feature Definition appears in 
different Models and Dynamic Views. 

Feature Symbologies use Element Templates to set the graphical properties and attributes for the 
Feature Definition in specific Models and Dynamic Views.  Typically, the Element Template is simple set of 
properties consisting of a Level, Color, Line Style, and Weight.  However, other settings can be assigned to 
an Element Template, such as Cells and Materials. 

 

 

Defaults: This is the master Element Template.  The Default Element Template is used when an 
Element Template is NOT assigned in a View category (i.e., Plan, Profile Intersection, 3D, 
Dynamic Cross Sections). 

For example, in the graphic above, the 3D Element Template is set to None meaning that the 
Default Element Template is used when the Feature Definitions is shown in 3D Design Model . 

 

Plan: Determines the Feature Definition properties in the 2D Design Model  (plan view).  This 
category is unique because a separate Element Template can be assigned for the Arc and Spiral 
portions of the Linear element. 

NOTE: The “Baseline” Feature Definition utilizes these options to show the Line portions in Red, 
Arcs in blue, and Spirals in white.   

 

Profile Intersection: This category is relevant when the Profile Intersection Point tool is used. 

NOTE: Most Feature Definitions use the “Proposed/Profiles/Intersecting Profile” Element 
Template to show a pink dot when the Profile Intersection Point tool is used. 

 3D: Determines the Feature Definition properties in the 3D Design Model . 

 

Dynamic Cross Section: Determines the Feature Definition properties in Dynamic Cross Section 
View  for a Corridor. 

NOTE: Guardrail Feature Definitions use an Element Template that contains a Cell to show a 
guardrail graphic in the Dynamic Cross Section View . 
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17C.2 Edit an Element Template 

Element Templates are edited in the Element Template Manager.  Opening the Element Template Manager 
is shown below: 
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17D – CREATE A NEW FEATURE DEFINITION 

In this demonstration, a new Mesh Feature Definition is created for use in a Corridor, Linear Template, or 
Surface Template.  After this workflow, the new Feature Definition is selectable in the Template Editor.   
However, the new Feature Definition is ONLY available in the ORD File that it was created in. 

NOTE: This workflow is applicable to any Feature Definition Type, including Linear and Alignment Feature 
Definitions. 

BEST PRACTICE: Creating a new Feature Definition from scratch is NOT encouraged.  Instead, create a 
copy of a similar Feature Definition and rename it. 

WARNING: Creating a new Feature Definition should ONLY be done if a suitable Feature Definition 
CANNOT be found in the FLH Feature Definition Library. 

In this workflow, a Mesh Feature Definition is needed to represent Brick Pavers.   The FLH Feature 
Definition Library does not have a Brick Feature Definitions.  Instead, the “Sidewalk Layer 1” Feature 
Definition is copied as the basis for the new Feature Definition. 

 

Browse the FLH Feature Definition Library to locate a comparable Feature Definition. 

NOTE: Locate a Feature Definition from the Libraries drop-down.  The entire FLH Feature 
Definition Library is shown from this location. 

 
Right-Click on a Feature Definition and select Copy. 
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Expand the Current ORD File drop-down.  In this case, the “grte201701_cor.dgn (Design 
SurvFT)” drop-down. 

 Expand the Feature Definitions drop-down. 

 Expand the Mesh drop-down.  

 
Right-Click on the Mesh drop-down and select Paste. 

 Assign the new Feature Definition an appropriate Name. 
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NOTE: The new Feature Definition will have the same Level, attributes, and properties as the copied 
Feature Definition.  To edit the Feature Definition and corresponding Element Templates, see 17C – 
Feature Definition Settings and Editor. 

After the new Feature Definition is created, it will be shown in the FLH Feature Definition Libraries.  As 
shown below, the new Feature Definition is available in the Template Editor and can be assigned to the 
desired Component. 
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17E – FIX UNSYNCHRONIZED FEATURE DEFINITIONS AND ALIGNMENT 
ANNOTATIONS 

Occasionally, elements that contain Feature Definitions and Alignment Annotations become 
unsynchronized with the default FLH Standards.  When this happens, Alignment Annotation text may be 
placed in the wrong location and contain incorrect text characteristics, such as font, color, and height.  
Elements with Feature Definitions may be out of sync with the FLH Standards if shown with the incorrect 
Color, Line Style, or Line Weight. 

 

Updating the Feature Definition and Alignment Annotations to FLH Standards is a two-part process.  First, 
open the Element Template Manager and run the Update Templates from Library tool. 
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Next, open the OpenRoads Standards drop-down in the Explorer .  Right-Click on the Active File 
Library and select Update Standards From dgnlib. 

 

After standards have been updated in both the Element Template Manager and OpenRoads Standards 
drop-down, Feature Definitions and Alignment Annotations should reflect the default FLH Standards: 
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